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Conformity / Supplemental Information:
The product complies with the requirements of the Low Voltage Directive 73/23/EEC and the EMC Directive 89/336/EEC 
(including 93/68/EEC) and carries the CE Marking accordingly. Contact the manufacturer for more information.

Limited Lifetime Warranty
Alicat Scientific, Inc. warrants to the original purchaser (hereinafter referred to as “Buyer”) that instruments manufactured 
by Alicat Scientific (hereinafter referred to as “Product”) shall be free from defects in materials and workmanship for the life 
of the Products.
Under this warranty, the Product will be repaired or replaced at manufacturer’s option, without charge for parts or labor when 
the Product is carried or shipped prepaid to the factory together with proof of purchase.
The foregoing shall constitute the exclusive and sole remedy in lieu of other remedies of the Buyer for any breach by Alicat 
Scientific of this warranty to the maximum extent permitted by law.
This warranty does not apply to any Product which has not been installed or used in accordance with the Product operation 
and installation specifications provided to Buyer verbally or in writing by Alicat Scientific for the proper and normal use of 
the Product.
Buyer agrees hereunder that Alicat reserves the right to void any warranty, written or implied, if upon Alicat’s examination of 
Product shall disclose to Alicat’s satisfaction that the Product failure was due solely, or in part, to accident, misuse, neglect, 
abuse, alteration, improper installation, unauthorized repair or improper testing by Buyer or agent of Buyer.
Alicat Scientific shall not be liable under any circumstances for indirect, special, consequential, or incidental damages in 
connection with, or arising out of, the sale, performance, or use of the Products covered by this warranty.
Alicat Scientific does not recommend, warrant or assume responsibility for the use of the Products in life support applications 
or systems.
Alicat’s warranties as herein above set forth shall not be enlarged, diminished or affected by, and no obligation or liability 
shall arise or grow out of Alicat’s rendering of technical advice in connection with Buyer’s order of the Products furnished 
hereunder.
If Product becomes obsolete, Alicat Scientific, at its own discretion, reserves the right to repair the Product with available 
replacement parts or upgrade the Product to a current , commercially available version of the original Product. Should 
upgrading the Product be deemed necessary by Alicat, Buyer hereby agrees to pay an upgrade fee equal to seventy percent 
of the retail value of the replacement Product. Alicat Scientific hereunder makes no claim that replacement Products will 
look, function or operate in the same or similar manner as the original product.
When a Product is returned to Alicat Scientific for recalibration this service is considered normal preventative maintenance. 
Recalibration of Product shall not be treated as a warranty service unless recalibration of Product is required as the result 
of repairs to Product pursuant to this Warranty. Failure to recalibrate Product on a yearly basis will remove any and 
all obligations regarding repair or replacement of Product as outlined by this Warranty to Buyer from Alicat 
Scientific.
This Warranty is in lieu of all other relevant warranties, expressed or implied, including the implied warranty of merchantability 
and the implied warranty of fitness for a particular purpose, and any warranty against infringement of any patent.
Continued use or possession of Products after expiration of the applicable warranty period stated above shall be conclusive 
evidence that the warranty is fulfilled to the full satisfaction of Buyer. 
Alicat makes no warranty as to experimental, non-standard or developmental Products.
Accessories purchased from Alicat are not covered by this warranty.

Notice: Alicat Scientific, Inc. reserves the right to make any changes and improvements to the products described in this 
manual at any time and without notice. This manual is copyrighted. This document may not, in whole or in part, be copied, 
reproduced, translated, or converted to any electronic medium or machine readable form, for commercial purposes, 
without prior written consent from the copyright holder.
Note: Although we provide assistance on Alicat Scientific products both personally and through our literature, it is the 
complete responsibility of the user to determine the suitability of any product to their application.
Alicat Scientific, Inc.’s Wide-Range Laminar Flow Element Patent: The wide-range laminar flow element and products 
using the wide-range laminar flow element are covered by U.S. Patent Number: 5,511,416. Manufacture or use of the 
wide-range laminar flow element in products other than Alicat Scientific products or other products licensed under said 
patent will be deemed an infringement.



Notes for Using Alicat Water Flow Devices
USE ONLY PURE, CLEAN DI OR DISTILLED WATER IN THIS DEVICE.►►  

DO NOT►►  use tap water, water with any biological components, minerals or oils. Any 
of these substances will affect the viscosity of the water (creating flow measurement 
inaccuracies). More importantly, any impurities will quickly build up inside 
the small laminar flow channels and damage the sensors.  
If you cannot meet the requirement of pure water, then do not use the Alicat water 
flow device in your application. Damage caused by impurity build up is not covered by 
the warranty.

Please read the operating manual that accompanied your device. Keep the manual for ►►
future reference.

When first using the Alicat water meter or controller for the day, please take the ►►
following precautions:

Apply your source pressure (approx. 20-30 PSIG for best results) to the device with 1.	
the downstream flow blocked off. 

Then slightly open both bleed ports (DO NOT completely remove the screws) and 2.	
allow any trapped air to escape. Allow some flow and let water pass through while 
bleeding (if the unit is a controller be sure to give it at least a 50% set-point). See 
page 8 of the manual for more information regarding bleed ports and bleeding.

Try not to get any water in-between the black electronics case and the stainless 3.	
steel flow body. Wipe up any excess water around these seams. 

Tighten up both bleed screws, and then block the downstream water flow again. 4.	
Visually verify zero flow through. 

Now you can safely tare (zero) a meter (5.	 page 13) using the tare button on the 
device, or in the case of a water flow controller, command the zero set‑point (page 
18) which will auto-tare the unit.

Smooth and consistent source pressure is highly preferable, as any pulsing or ►►
fluctuation in water pressure will hydraulically couple to the differential pressure 
sensor, and the resultant flow reading will jump analogously.

Please note that, depending on model and flow range, water flow meters have an ►►
inherent internal pressure drop higher than that of standard gas flow meters. The 
minimum water device pressure drop is 2 PSIG, going all the way to 20 PSIG drop in 
certain models. Your source input pressure must meet or exceed this specification, 
in addition to any back pressure you may have on the downstream end of your 
process. Please see page 29 of the manual or check our online specifications chart for 
model specific details (http://www.alicatscientific.com/documents/specifications/
LiquidFlowMeterController.pdf.)

Please contact Alicat if you have any questions. We will be happy to help.

email: info@alicatscientific.com

tel: 520-290-6060  or  888-290-6060

Alicat Scientific, Inc.
7641 N Business Park Drive
Tucson, AZ 85743    USA
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Thank you for purchasing an L Series Water Flow Meter or LC Water Flow Controller. Please take 
the time to find and read the information contained in this manual. This will help to ensure that you 
get the best possible service from your instrument. This manual covers the following Alicat Scientific 
instruments:

	 L Series Water Flow Meters		  L-XXCCM-D
							       L-XXLPM-D
	 LC Series Water Flow Controllers		 LC-XXCCM-D
							       LC-XXLPM-D
							       LCR-XXLPM-D
	 Alicat Portable Water Meters

(Note: All Alicat Portable Water Meters operate in accordance with the instructions found in 
this manual. Please see page 36 for information regarding battery replacement.)

Flow Measurement Operating Principle
All L or LC Series Water Flow Meters/Controllers accurately determine the flow rate by creating a 
pressure drop across a unique internal restriction, known as a Laminar Flow Element (LFE), and 
measuring differential pressure across it. The restriction is designed so that the water molecules are 
forced to move in parallel paths along the entire length of the passage; hence laminar (streamline) flow 
is established for the entire range of operation of the device. Unlike other flow measuring devices, in 
laminar flow meters the relationship between pressure drop and flow is linear. The underlying principle 
of operation of the 16 Series Flow Meters is known as the Poiseuille Equation:

Q = (P1-P2)πr4/8ηL					           (Equation 1)
Where: Q  = Volumetric Flow Rate

P1 = Static pressure at the inlet
P2 = Static pressure at the outlet
r = Radius of the restriction
η = (eta) absolute viscosity of the fluid
L = Length of the restriction

 Since p, r and L are constant; Equation 1 can be rewritten as:

Q = K (∆P/η) 						            (Equation 2)
Where K is a constant factor determined by the geometry of the restriction. Equation 2 shows the linear 
relationship between volumetric flow rate (Q) differential pressure (DP) and absolute viscosity (h) in a 
simpler form.

In order to have an accurate reading of the flow rate, the absolute viscosity of the fluid must be 
established. The rate at which liquids change viscosity with changes in temperature is not linear. The 
relationship between temperature and viscosity for water is well established and Alicat Scientific L and 
LC Series units utilize a high accuracy temperature sensor and this relationship to provide an accurate 
viscosity reference. For this reason, these meters and controllers are generally recommended 
only for use with pure water. Any additives to water (such as antifreeze or disinfectants) that might 
affect the viscosity should be avoided. As shown in Equation 2, an error in viscosity between the actual 
fluid and water will result in a 1:1 error percentage in the flow rate reported by the meter. For instance if 
the actual fluid passing through the meter is 5% different than that of pure water at a given temperature, 
the reported flow rate will be 5% inaccurate.
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Flow Control Operating Principle

For the purposes of this explanation, the term “valve” will refer to the proportional control valve mounted 
on the controller. The term “controller” will refer to the flow meter and the measurement and control 
electronics portion of the device. In actuality, the whole device is generally referred to as a controller. 
The valve normally mounted downstream of the controller.

LC Series Flow Controllers ship with a normally closed proportional control valve. No flow will occur 
until the valve receives a voltage signal from the controller, and the controller will not send a voltage 
signal to the valve until the user provides a set-point to the controller. The user can provide a set-point 
either locally via the display and user interface buttons, or more commonly, by providing an external 
signal that corresponds to the flow range of the controller. This external signal can be an analog voltage 
or current signal such as a 0-5 Vdc or 4-20 mA signal, or a digital RS-232 / RS-485 signal via serial 
communication with a computer.

The controller utilizes what is called PID (Proportional, Integral, Derivative) loop control circuitry and 
software. The PID loop control works by repeatedly comparing the measured flow rate to the set-
point and incrementally adjusting the voltage signal to the valve in a continuous attempt to match the 
measured flow rate to the set-point. For example, at any given time the controller looks at the measured 
flow rate and the set-point, if the set-point is higher than the measured flow rate, the controller will 
slightly increase the voltage signal to the valve and thus open it little more. If the set-point is lower than 
the measured flow rate, the controller will slightly decrease the voltage signal to the valve and thus 
close it off a little more. This look, compare, and adjust “loop” occurs on the order of 1000 times each 
second.

LC Series Flow Controllers ship with a general PID tuning that is usually sufficient for most applications. 
Occasionally an application will require the customer to change this tuning. The Proportional and 
Derivative terms can be field adjusted in all LC controllers. In very general terms, the P term can be 
thought of as how fast the controller responds to change and the D term can be thought of as a damping 
factor.
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Installation

Plumbing

All L Series Meters and LC Series Controllers are equipped with female inlet and outlet port connections. 
Because the flow meters set up a laminar flow condition within the flow body, no straight runs of pipe 
are required upstream or downstream of the meter. The inlet and outlet ports are equal in size and 
symmetric (in-line). The port sizes (process connections) and mechanical dimensions for different flow 
ranges are shown on page 30.

Meters with M5 (10-32) ports have o-ring face seals and require no further sealant or tape. On other 
meters/controllers, avoid the use of pipe dopes or sealants on the ports as these compounds can cause 
permanent damage to the meter should they get into the flow stream. Use of thread sealing Teflon tape 
is recommended to prevent leakage around the threads. When applying the tape, avoid wrapping the 
first thread or two to minimize the possibility of getting a piece of shredded tape into the flow stream. 
When changing fittings, always clean any tape or debris from the port threads.

It is also recommended that a 20 micron filter be installed upstream of meters/controllers with full scale 
ranges of 100CCM or less and a 50 micron filter be installed upstream of meters/controllers with full 
scale ranges above 100CCM.

Note: Avoiding long runs of small diameter tubing upstream or downstream of controllers will 
reduce water hammer.

Mounting

All L Series Meters and LC Series Controllers have mounting holes for convenient mounting to flat 
panels. These meters are position insensitive and can be mounted in any orientation. The sizes and 
dimensions for the mounting holes are shown on pages 31-33.

Note: For applications that may continuously introduce occasional air bubbles to the flow stream 
upstream of the device, the device may be mounted upside down to prevent the bubbles from becoming 
trapped in the differential pressure sensor ports. If the device has been installed upside down, avoid 
using the bleed screws as water may leak into the electronics housing causing permanent damage that 
is not covered under warranty!

Application

Maximum operating line pressure is 100 PSIG (689 kPa). Caution: Exceeding the maximum specified 
line pressure may cause permanent damage to the solid-state differential pressure transducer.

If the line pressure is higher than the 100 PSIG (689 kPa), a pressure regulator should be used upstream 
from the flow meter to reduce the pressure to 100 PSIG (689 kPa) or less if possible. Although the 
meter’s operation is uni-directional, reversing the flow direction will inflict no damage as long as the 
maximum specified limits are not exceeded. The differential pressure sensor utilized in this flow meter/
controller is a very sensitive device capable of detecting minute differences in pressure.

Avoid installations (such as snap acting solenoid valves upstream) that apply instantaneous 
high pressure to the meter as permanent damage to the differential pressure sensor could 
result. This damage is not covered under warranty!
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Bleed Ports

Alicat Scientific L and LC Series flow meters and controllers are equipped with bleed ports on the front 
to aid in the removal of air bubbles from the differential pressure sensor ports. The bleed ports consist 
of a threaded hole with an 8-32 nylon tipped screw as shown in Figure 1. After installation or anytime it 
is suspected that air may be trapped in the sensor ports, bleed the ports as follows:

CAUTION: A small amount of water will leak from the device during this procedure. Take necessary 
precautions to prevent the leaking water from damaging anything around the unit, taking special care 
to avoid any live electrical devices or lines.

With the meter/controller installed and line pressure applied, gently loosen the upstream bleed port 
screw 1-2 turns or until water begins to leak from the threads. DO NOT REMOVE THE SCREW as the 
port is subject to line pressures and injury, equipment damage, or loss of required parts may result!

Gently tap the flow body (a wooden or plastic screwdriver handle works well for this) to encourage air 
bubbles to exit the port.

Any air in the port will generally be removed as the water leaks out even though you may not see or 
hear it.

Gently tighten the screw until the leakage stops, taking care not to crush the nylon tip.

Repeat steps 1-4 with the second bleed port.

 
Figure 1. Bleed Ports

8-32 Nylon Tipped Bleed Screw
5/64 Hex  Loosen to Bleed
DO NOT REMOVE!
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Power and Signal Connections
Power can be supplied to your meter or controller through either the AC/DC adapter jack or through the 
8 pin Mini-DIN connector as shown in Figure 1.
A 2.1mm, positive center, 7-30 Vdc AC/DC adapter rated for at least 100 mA is required to use the 
adapter jack in a L Series meter.
A 2.1mm, positive center, 12-30 Vdc AC/DC adapter rated for at least 250 mA is required to use the 
adapter jack in a LC Series controller. Note: 4-20mA output requires at least 15 Vdc.
A 2.1mm, positive center, 24-30 Vdc AC/DC adapter rated for at least 500 mA is required to use the 
adapter jack in a LCR Series controller.
Cables can be purchased from the manufacturer (see Accessories on page 40) or they are available 
from electronics suppliers. Alternatively, power can be supplied through the Mini-DIN connector as 
shown below:

7 8

1 2

3 4 5

AC/DC Adapter Jack

6

1

3

2

4 5

6 7 8

Pin Function Mini-DIN 
cable color

1 Inactive or 4-20mA Primary Output Signal Black

2 Static 5.12 Vdc or Secondary Analog Output (4-20mA, 5Vdc, 10Vdc) or 
Basic Alarm Brown

3 RS-232 Input Signal Red

4 Analog Input Signal = Remote Tare (Meters - see Figure 8)
                                = Set-Point In (Controllers - see Figure 3) Orange

5 RS-232 Output Signal Yellow
6 0-5 Vdc (or 0-10 Vdc) Output Signal Green
7 Power In (as descibed above) Blue
8 Ground (common for power, communications and signals) Purple

Note: The above pin-out is applicable to all the flow meters and controllers available with the Mini-
DIN connector. The availability of different output signals depends on the flow meter options ordered.
Underlined Items in the above table are optional configurations that are noted on the unit’s 
calibration sheet.

Figure 2. 8 Pin Mini-DIN Connector
CAUTION:Do not connect power to pins 1 through 6 as permanent damage can occur!

Note: Upon initial review of the pin out diagram in Figure 2, it is common to mistake Pin 2 (labeled 
5.12 Vdc Output) as the standard 0-5 Vdc analog output signal! In fact Pin 2 is normally a constant 
5.12 Vdc that reflects the system bus voltage and can be used as a source for the input signal. This 
allows the user in the field to run this output through a 50K ohm potentiometer and back into the analog 
set-point pin to create a 0-5 Vdc set-point source (see Figure 3).



11

Analog Input Signal
Apply analog input to Pin 4 as shown in Figure 2.
Unless ordered otherwise, 0-5 Vdc is the standard analog input signal. Apply the 0-5 Vdc input signal 
to pin 4, with common ground on pin 8. The 5.12 Vdc output on pin 2 can be wired through a 50K ohm 
potentiometer and back to the analog input on pin 4 to create an adjustable 0-5 Vdc input signal source 
as in Figure 3 below.

 

7 6

5 4 3

2 1

8

5.12 Vdc

50 KOhm 
Potentiometer

0-5 Vdc

Figure 3.  Simple Method for Providing Set-Point to Controllers
Optional 0-10 Vdc: If specified at time of order, a 0-10 Vdc input signal can be applied to pin 4, with 
common ground on pin 8.
Optional 4-20 mA: If specified at time of order, a 4-20 mA input signal can be applied to pin 4, with 
common ground on pin 8.
RS-232 Digital Input Signal
If you will be using the RS-232 output signal, it is necessary to connect the RS-232 Output Signal (Pin 5), 
the RS-232 Input Signal (Pin 3), and Ground (Pin 8) to your computer serial port as shown in Figure 4. 
Adapter cables are available from Alicat (see Accessories page 40) or they can be constructed in the 
field with parts from a local electronic supply house. In Figure 4, note that the diagrams represent the 
“port” side of the connections, i.e. the connector on top of the meter and the physical DB-9 serial port 
on the back of the computer. The cable ends will be mirror images of the diagram shown in Figure 4. 
(See page 22 for details on accessing RS-232 output and input.) 
Optional RS-485 Digital Input Signal
If you will be using the RS-485 output signal, it is necessary to connect the RS-485 Input Signal with 
the appropriate DB15 pin out as shown on pages 43 and 44. If your device is configured with a 6-pin 
industrial connector please see Figure 4. (See page 22 for details on accessing RS-485 output.)
RS-232 Digital Output Signal
If you will be using the RS-232 output signal, it is necessary to connect the RS-232 Output Signal 
(Pin 5), the RS-232 Input Signal (Pin 3), and Ground (Pin 8) to your computer serial port as shown in 
Figure 4. Adapter cables are available from the manufacturer or they can be constructed in the field with 
parts from an electronics supply house. In Figure 4, note that the diagrams represent the “port” side of 
the connections, i.e. the connector on top of the meter and the physical DB-9 serial port on the back of 
the computer. The cable ends will be mirror images of the diagram shown in Figure 4. (See page 22 for 
details on accessing RS-232 output.)
Optional RS-485 Digital Output Signal
If you will be using the RS-485 output signal, it is necessary to connect the RS-485 Output Signal with 
the appropriate DB15 pin out as shown on pages 43 and 44. If your device is configured with a 6-pin 
industrial connector please see Figure 4. (See page 22 for details on accessing RS-485 output.)
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Standard Voltage (0-5 Vdc) Output Signal
All L and LC Series flow meters/controllers have a 0-5 Vdc (optional 0-10 Vdc) output signal available on 
Pin 6. This is generally available in addition to other optionally ordered outputs. This voltage is usually 
in the range of 0.010 Vdc for zero flow and 5.0 Vdc for full-scale flow. The output voltage is linear over 
the entire range. Ground for this signal is common on Pin 8.
Optional 0-10 Vdc Output Signal
If your meter/controller was ordered with a 0-10 Vdc output signal, it will be available on Pin 6.  (See the 
Calibration Data Sheet that shipped with your device to determine which output signals were ordered.) 
This voltage is usually in the range of 0.010 Vdc for zero flow and 10.0 Vdc for full-scale flow. The 
output voltage is linear over the entire range. Ground for this signal is common on Pin 8.
Optional Current (4-20 mA) Output Signal
If your meter/controller was ordered with a 4-20 mA current output signal, it will be available on Pin 1. 
(See the Calibration Data Sheet that shipped with your device to determine which output signals were 
ordered.) The current signal is 4 mA at 0 flow and 20 mA at the meter’s full scale flow. The output 
current is linear over the entire range. Ground for this signal is common on Pin 8. (Current output units 
require 15-30Vdc power.)

Note: This is a current sourcing device. Do not attempt to connect it to “loop powered “ systems.
Optional 2nd Analog Output Signal
You may specify an optional 2nd analog output on Pin 2 at time of order. (See the Calibration Data 
Sheet that shipped with your device to determine which output signals were ordered.) This output may 
be a 0-5 Vdc, 0-10 Vdc, or 4-20 mA analog signal that can represent any measured parameter. 

Note: This is a current sourcing device. Do not attempt to connect it to “loop powered “ systems.

7

4

6

21

DB-9 Serial Port

5

5----------Ground--------------------------------------Ground----------8
3----------Transmit------------------------------------Receive---------3
2----------Receive-------------------------------------Transmit--------5

8 Pin Mini-DIN Port

8

1 2 3 4 5

6 7 8 9
3

 

4 5
6 7 8

2

Figure 4. Mini-DIN to DB-9 Connection for RS-232 Signals
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5
3

2

Purple

Red
Yellow

Purple

Red
Yellow

5 4 3 2
1

9
8 7

6

Unit C

Unit B

Unit A

Female Serial Cable Front

Purple (Ground)

Red
Yellow

Figure 5.  Typical Multiple Device (Addressable) Wiring Configuration
Note: The easiest way to connect multiple devices is with a Multi-Drop Box (see page 38).

An optional industrial connector is also available:

1
6

5

4
3

2

Pin Function Cable Color
1 Power In  ( + ) Red
2 RS-232TX / RS-485 + Blue
3 RS-232RX / RS-485 - White
4 Analog Input Signal Green
5 Ground (common for power,

                     communications and signals)
Black

6 Signal Out (Voltage or Current as ordered) Brown

Figure 6. Optional Industrial Connector
Note: The above pin-out is applicable to all the flow meters and controllers ordered with the industrial 
connector. The availability of different output signals depends on the flow meter options ordered.
DB15 Pin-out Diagrams: Pin-out diagrams for devices ordered with a DB15 connector can be 
found on pages 43 and 44.

PROFIBUS Pin-out Diagrams: Pin-out diagrams for PROFIBUS configured devices can be found 
on page 33 and 42. 
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L Series Water Flow Meter Operation

The L Series can have several screen “modes” depending on how the device is ordered. All L Series 
meters have a default Main Mode, Select Menu Mode, a Communication Select Mode, a Manufacturer 
Data Mode and a Miscellaneous Mode. (In addition, your meter may have been ordered with the 
Totalizing Mode option, see page 36.) The device defaults to Main Mode as soon as power is applied 
to the meter.

Note: L Series Flow Meters may also be ordered as portable devices as described on page 37.

Main Mode

The main mode screen shows the flow in the units specified at time of order, the line pressure in PSIG, 
and the process temperature in degrees Celsius. The following parameters are displayed in the main 
mode as shown in Figure 7:

 PSIG         oC          Tare
  +23.47      +22.73

					       
					      CCM
  					      Water
    
  +0.000
  Volume                   Main

Figure 7. Main Mode Display, L Series Flow Meter

 The “MODE” button in the lower right hand corner toggles the display between modes.

Tare – Pushing the dynamically labeled Tare button in the upper right hand corner tares the flow meter 
and provides it with a reference point for zero flow. This is a very simple but important step in obtaining 
accurate measurements. It is good practice to “zero” the flow meter each time it is powered up and 
whenever a known zero flow condition exists. If the flow reading varies significantly from zero after an 
initial tare, give the unit a minute or so to warm up and re-zero it. If possible, it is helpful to zero the unit 
near the expected operating pressure by positively blocking the flow downstream of the flow meter prior 
to pushing the “Tare” button. Zeroing the unit while there is any flow will directly affect the accuracy by 
providing a false zero point. It is not uncommon for a meter to read a small value when it is removed 
from the process line as water can “hang” in one or both of the differential pressure sensor ports. If the 
unit reads a significant negative value when removed from the line and blocked, it is a good indication 
that it was given a false zero.

Note: A remote tare can be achieved by momentarily grounding pin 4 to tare as shown in Figure  8 on 
page 15.
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Line Pressure – Pressing the dynamically labeled PSIG button located in the upper left corner of the 
display will move the line gauge pressure to the primary display.

Line Temperature – Pressing the dynamically labeled °C button located in the upper middle of the 
display will move the process temperature to the primary display.

Volume – The volume flow rate is defaulted on the primary display. Pressing the dynamically labeled 
“Volume” button will move the volume flow rate to the primary display if another parameter is displayed 
there.

Flashing Error Message: Our flow meters and controllers display an error message (VOV = volumetric 
overrange, POV = pressure overrange, TOV = temperature overrange) when a measured parameter 
exceeds the range of the sensors in the device. When any item flashes on the display, neither the 
flashing parameter nor the flow measurement is accurate. Reducing the value of the flashing parameter 
to within specified limits will return the unit to normal operation and accuracy.

Figure 8. Proper Set Up for Remote Tare on Meters (Momentarily ground Pin 4 to Tare)

Select Menu Mode

Pushing “Mode” once will bring up the “Select Menu” display. Push the button nearest your selection to 
go to the corresponding screen. Push “Mode” again to return to the Main Mode display. (Note: If your 
meter was ordered with Totalizing Mode option (page 36), pushing the “Mode” button once will bring up 
the “Totalizing Mode” display.  Pushing “Mode” a second time will bring up the “Select Menu” display.)

                     Misc

SELECT
MENU

Comm.      Mfg.
RS-232     Data      Menu

Figure 9. Select Menu Display
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Communication Select Mode

The Communication Select mode is accessed by pressing the button below “Comm. RS-232” or “Comm. 
RS-485” on the Select Menu display. The screen will appear as shown in Figure 10 below.

Select

>
 Unit ID (A).....A
 Baud (19200)....19200
 Data Rate......Fast

Comm.
   UP       DOWN    RS-232

Figure 10. Communication Select Display

Unit ID – Valid unit identifiers are letters A-Z and @ (see Note below). This identifier allows the user to 
assign a unique address to each device so that multiple units can be connected to a single RS-232 or 
RS-485 port on a computer. The Communication Select Mode allows you to view and/or change a unit’s 
unique address. To change the unit ID address, press the “Select” button in the upper left corner of the 
display until the cursor arrow is in front of the word “Unit ID”. Then, using the UP and DOWN buttons at 
the bottom of the display, change the unit ID to the desired letter. Any ID change will take effect when 
the Communication Select Screen is exited by pushing the MODE button.
Note: When the symbol @ is selected as the unit ID, the device will go into streaming mode when the 
Communication Select Mode is exited by pushing the MODE button. See the RS-232 Communications 
chapter in this manual for information about the streaming mode. Note: RS‑485 units do not have a 
streaming mode.
Baud – The baud rate (bits per second) determines the rate at which data is passed back and forth 
between the instrument and the computer. Both devices must send/receive at the same baud rate in 
order for the devices to communicate via RS-232 or RS-485. The default baud rate for these devices 
is 19200 baud, sometimes referred to as 19.2K baud. To change the baud rate in the Communication 
Select Mode, press the “Select” button in the upper left corner of the display until the cursor arrow is 
in front of the word “Baud”. Then, using the UP and DOWN buttons at the bottom of the display, select 
the required baud rate to match your computer or PLC. The choices are 38400, 19200, 9600, or 2400 
baud. Any baud rate change will not take effect until power to the unit is cycled.
Data Rate – Changing the Data Rate affects the rate at which the instrument dumps its data. Slow is 
½ the Fast rate. The speed of the Fast rate is determined by the selected baud rate. It is sometimes 
desirable to reduce the data rate if the communication speed bogs down the computer’s processor (as 
is not uncommon in older laptops), or to reduce the size of data files collected in the streaming mode. 
To change the data rate in the Communication Select Mode, press the “Select” button in the upper left 
corner of the display until the cursor arrow is in front of the word “Data Rate”. Then, using the UP and 
DOWN buttons at the bottom of the display, select either Fast or Slow. Any data rate change will be 
effective immediately upon changing the value between Fast and Slow.
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Manufacturer Data Mode

“Manufacturer Data” is accessed by pressing the “Mfg. Data” button on the Select Menu display (Figure 
7). The “Mfg 1” display shows the name and telephone number of the manufacturer. The “Mfg 2” display 
shows important information about your flow meter including the model number, serial number, and 
date of manufacture. 

Main

Alicat Scientific, Inc.

Ph 520-290-6060
Fax 520-290-0109

Mfg 1

Main

Model L-10LPM-D
Serial No 27117
Date Mfg.11/07/2009
Calibrated By.DL

Software GP07R23	
Mfg 2

Figure 11. Manufacturer Data Displays

Miscellaneous Mode
The Miscellaneous mode is accessed by pressing the button above the “Misc” label in the upper right 
hand corner of the Select Menu display. The screen will appear as shown in Figure 12. Push the 
button above “Select” to move the cursor even with the item you wish to adjust. Then use the “UP” and 
“DOWN” buttons to make the adjustment.

NOTE: All Miscellaneous changes are recorded when you exit the Miscellaneous display.
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Select				    Main
>
LCD Contrast(10)   .		 10
PVM DBand (0.5% FS)
PRESS Avg (008) . . .	 008
FLOW Avg (100) . . . .	 100

UP        DOWN      Misc

Figure 12. Miscellaneous Display
LCD Contrast: The Liquid Crystal Display Contrast can be adjusted between 0 and 30 with zero being 
the lightest contrast and 30 being the darkest contrast. To change the contrast, press the “Select” 
button in the upper left hand corner of the display until the cursor arrow is in front of the words “LCD 
Contrast (X)”. Then using the UP and DOWN buttons at the bottom of the display, change the contrast 
value as desired. The change is immediate and the effect can be monitored as the value is changed.
Display Zero Deadband: Zero deadband refers to a value below which the display simply jumps to zero. 
This deadband is often desired to prevent electrical noise from showing up on the display as minor flows 
or pressures that do not actually exist, especially in high noise (electrical) environments. This display 
deadband does not affect the analog or digital signal outputs — there is no zero deadband on the output 
signals. The display zero deadband can be adjusted between 0 and 3.2% of the Full Scale (FS) of the 
sensor. PVM refers to Pressure, Volumetric Flow, and Mass Flow, the three parameters to which the 
deadband applies. Note: Only Pressure and Volumteric Flow are applicable to and adjustable in liquid 
devices. To adjust the display zero deadband, press the “Select” button in the upper left hand corner of 
the display until the cursor arrow is in front of the words “PVM DBand (X %F.S.)”. Then using the UP 
and DOWN buttons at the bottom of the display, change the display zero deadband value as desired.
Pressure Averaging: It is sometimes advantageous to apply an averaging factor to the pressure output 
(and display) to make it easier to read and interpret rapidly fluctuating pressures. Pressure averaging 
can be adjusted between 1 (no averaging) and 256 (maximum averaging). This is a geometric running 
average where the number between 1 and 256 can be considered very roughly equivalent to the 
response time constant in milliseconds. This can be very effective at “smoothing” high frequency process 
oscillations such as those caused by diaphragm pumps. To adjust the pressure averaging, press the 
“Select” button in the upper left hand corner of the display until the cursor arrow is in front of the words 
“PRESS Avg (XXX)”. Then using the UP and DOWN buttons at the bottom of the display, change the 
pressure averaging value as desired.
Flow Averaging: It is sometimes advantageous to apply an averaging factor to the flow output (and 
display) to make it easier to read and interpret rapidly fluctuating flows. Flow averaging can be adjusted 
between 1 (no averaging) and 256 (maximum averaging). This is a geometric running average where 
the number between 1 and 256 can be considered very roughly equivalent to the response time constant 
in milliseconds. This can be very effective at “smoothing” high frequency process oscillations such as 
those caused by diaphragm pumps. To adjust the flow averaging, press the “Select” button in the upper 
left hand corner of the display until the cursor arrow is in front of the words “FLOW Avg (XXX)”. Then 
using the UP and DOWN buttons at the bottom of the display, change the flow averaging value as 
desired.
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LC Series Water Flow Controller Operation

The LC Series can have several screen “modes” depending on how the device is ordered. All LC Series 
controllers have a default Main Mode, a Select Menu Mode, a Control Setup Mode, a Communication 
Select Mode, a Manufacturer Data Mode and a Miscellaneous Mode. (In addition, your controller may 
have been ordered with the Totalizing Mode option, see page 36.) The device defaults to Main Mode as 
soon as power is applied to the meter.

Main Mode

The main mode screen shows the flow in the units specified at time of order, the line pressure in PSIG, 
and the process temperature in degrees Celsius.
 

 PSIG         oC         Set Pt.
  +23.47      +22.73       0.000

					       
					      CCM
  					      Water
    
  +0.000
  Volume                   Main

Figure 13. Main Mode Display, LC Series Water Flow Controller

The “MODE” button in the lower right hand corner toggles the display between the Main Display and 
the Select Menu Display.

Line Pressure – Pressing the dynamically labeled PSIG button located in the upper left corner of the 
display will move the line gauge pressure to the primary display.

Line Temperature – Pressing the dynamically labeled °C button located in the upper middle of the 
display will move the process temperature to the primary display.

Volume – The volume flow rate is defaulted on the primary display. Pressing the dynamically labeled 
“Volume” button will move the volume flow rate to the primary display if another parameter is displayed 
there.

Set Pt – The set-point is shown in the upper right corner of the display. The set-point cannot be adjusted 
from the main mode screen. (For information on changing the set-point, see the Control Set Up Mode 
below.)

Flashing Error Message: Our flow meters and controllers display an error message (VOV = volumetric 
overrange, POV = pressure overrange, TOV = temperature overrange) when a measured parameter 
exceeds the range of the sensors in the device. When any item flashes on the display, neither the 
flashing parameter nor the flow measurement is accurate. Reducing the value of the flashing parameter 
to within specified limits will return the unit to normal operation and accuracy.
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Select Menu Mode

Pushing “Mode” once will bring up the “Select Menu” display (Figure 9, page 15). Push the button 
nearest your selection to go to the corresponding screen. Push “Mode” again to return to the Main 
Mode display. (Note: If your meter was ordered with Totalizing Mode option (page 36), pushing the 
“Mode” button once will bring up the “Totalizing Mode” display. Pushing “Mode” a second time will bring 
up the “Select Menu” display.)

Control Setup Mode
The Control Setup Mode is accessed by pressing the button labeled “MODE” until the dynamic label 
over the button reads “Control Setup” as shown in Figure 11 below. This mode allows the user to set 
up most parameters commonly associated with PID control. LC Series flow controllers allow the user to 
select how the set-point is to be conveyed to the controller, what that set-point is if control is local, and 
what the Proportional and Differential terms of the PID control loop will be. The UP and DOWN buttons 
for adjusting variables can be held down for higher speed adjustment or pressed repeatedly for fine 
adjustment. 

 Select    Loop     Input

>P 200            >Analog
 D 500   >Volume   Serial
 AUT0on

     
         Local

 Set 0.00
Control

Up       Down     Setup

Figure 14.  LC Series Control Setup Display

Input – LC Series Flow Controllers normally ship defaulted to analog control as indicated in Figure 14 
above. To change how the set-point will be conveyed to the controller push the button in the upper right 
hand corner just above the dynamic label “Input” until the arrow is directly in front of the desired option. 
The controller will ignore any set-point except that of the selected input and it will remember which input 
is selected even if the power is disconnected.
Analog refers to a remote analog set-point applied to Pin 4 of the Mini-DIN connector as described 
in the installation section of this manual. To determine what type of analog set-point your controller 
was ordered with, refer to the Calibration Data Sheet that was included with your controller. 0-5 Vdc 
is standard unless ordered otherwise. Note that if nothing is connected to Pin 4, and the controller is 
set for analog control, the set-point will float. CAUTION! Never leave a Controller with any non-zero 
set‑point if no pressure is available to make flow. The controller will apply full power to the valve in an 
attempt to reach the set-point. When there is no flow, this can make the valve very HOT!
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Serial refers to a remote digital RS-232 / RS-485 set-point applied via a serial connection to a computer 
or PLC as described in the Installation and RS-232 / RS-485 sections of this manual. CAUTION! Never 
leave a Controller with any non-zero set-point if no pressure is available to make flow. The controller 
will apply full power to the valve in an attempt to reach the set-point. When there is no flow, this can 
make the valve very HOT!
Local refers to a set-point applied directly at the controller. For more information on changing the 
set-point locally refer to the heading “Select” below. Local input must be selected prior to attempting 
to change the set-point locally. CAUTION! Never leave a Controller with any non-zero set-point if no 
pressure is available to make flow.  The controller will apply full power to the valve in an attempt to 
reach the set-point. When there is no flow, this can make the valve very HOT!

Loop –  The LC is defaulted to volume flow.

Volume means that the controller is “closing the loop” on the volume flow rate. This means that when 
you give the controller a set-point, the controller compares that set-point to the measured volume flow 
rate and adjusts the valve to try to make the flow and the set-point match. For the volume flow rate, the 
input signal (e.g. 0-5 Vdc) corresponds to the full-scale flow rate for the device.

Select – To avoid accidental changing of the PID loop parameters or the set-point, the Control Setup 
mode defaults with the selector on a null position. To change the set-point or the P and D PID loop 
parameters, push the button in the upper left corner just above the dynamic label “Select” until the 
selection arrow is pointing to the parameter you wish to change. When the parameter you wish to 
change is selected, it may be adjusted up or down with the buttons under the display below the dynamic 
labels “UP” and “DOWN”. Press the buttons repeatedly to make slow adjustments or hold them down 
to make fast adjustments.

P refers to the Proportional term of the PID loop. Before changing this parameter, it is good practice to 
write down the initial value so that it can be returned to the factory settings if necessary.

D refers to the Differential term of the PID loop. Before changing this parameter, it is good practice to 
write down the initial value so that it can be returned to the factory settings if necessary.

AUT0on / AUT0off refers to the standard auto-tare or “auto-zero” feature. It is recommended that the 
controller be left in the default auto-tare ON mode unless your specific application requires that it be 
turned off. The auto-tare feature automatically tares (takes the detected signal as zero) the unit when it 
receives a zero set-point for more than two seconds. A zero set-point results in the closing of the valve 
and a known “no flow” condition. This feature helps to make the device more accurate by periodically 
removing any cumulative errors associated with drift.

Set refers to the Set-point. This parameter may only be changed if “Local” is selected as the Input. See 
above for information on selecting the input. Using the UP and DOWN buttons, the set-point may be 
adjusted between zero and the full-scale range of the controller. CAUTION! Never leave a Controller 
with any non-zero set-point if no pressure is available to make flow. The controller will apply full 
power to the valve in an attempt to reach the set-point. When there is no flow, this can make the valve 
very HOT!
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Communication Select Mode
The Communication Select mode is accessed by pressing the button below “Comm. RS-232” or 
“Comm. RS-485” on the Select Menu display. Please see page 15 for Communication Select mode 
instructions.
Manufacturer Data Mode
“Manufacturer Data” is accessed by pressing the “Mfg. Data” button on the Select Menu display 
(Figure 9, page 15). The “Mfg 1” display shows the name and telephone number of the manufacturer. 
The “Mfg 2” display shows important information about your flow meter including the model number, 
serial number, and date of manufacture (Figure 11, page 17). 

Miscellaneous Mode
The Miscellaneous mode is accessed by pressing the button above the “Misc” label in the upper right 
hand corner of the Select Menu display. The screen will appear as shown in Figure 12. Push the 
button above “Select” to move the cursor even with the item you wish to adjust. Then use the “UP” and 
“DOWN” buttons to make the adjustment. See pages 17 & 18.

NOTE: All Miscellaneous changes are recorded when you exit the Miscellaneous display.

RS-232 / RS-485 Output and Input
Configuring HyperTerminal®:

Open your HyperTerminal® RS-232 / RS-485 terminal program (installed under the “Accessories” 1.	
menu on all Microsoft Windows® operating systems).
Select “Properties” from the file menu.2.	
Click on the “Configure” button under the “Connect To” tab. Be sure the program is set for: 19,200 3.	
baud (or matches the baud rate selected in the RS-232 / RS-485 communications menu on the 
meter) and an 8-N-1-None (8 Data Bits, No Parity, 1 Stop Bit, and no Flow Control) protocol.
Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI or Auto Detect.4.	
Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line Feeds” box 5.	 is not 
checked and the “Echo Typed Characters Locally” box and the “Append Line Feeds to Incoming 
Lines” boxes are checked. Those settings not mentioned here are normally okay in the default 
position.
Save the settings, close HyperTerminal® and reopen it.6.	

In Polling Mode, the screen should be blank except the blinking cursor. In order to get the data 
streaming to the screen, hit the “Enter” key several times to clear any extraneous information. Type 
“*@=@” followed by “Enter” (or using the RS-232 / RS-485 communication select menu, select @ as 
identifier and exit the screen). If data still does not appear, check all the connections and com port 
assignments.
Changing From Streaming to Polling Mode: 
When the meter is in the Streaming Mode (RS-485 units do not have a streaming mode), the screen is 
updated approximately 10-60 times per second (depending on the amount of data on each line) so that 
the user sees the data essentially in real time. It is sometimes desirable, and necessary when using 
more than one unit on a single RS-232 line, to be able to poll the unit.
In Polling Mode the unit measures the flow normally, but only sends a line of data when it is “polled”. 
Each unit can be given its own unique identifier or address. Unless otherwise specified each unit is 
shipped with a default address of capital A. Other valid addresses are B thru Z.
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Once you have established communication with the unit and have a stream of information filling your 
screen:

Type *@=A followed by “Enter” (or using the RS-232 / RS-485 communication select menu, select 1.	
A as identifier and exit the screen) to stop the streaming mode of information. Note that the flow of 
information will not stop while you are typing and you will not be able to read what you have typed. 
Also, the unit does not accept a backspace or delete in the line so it must be typed correctly. If in 
doubt, simply hit enter and start again. If the unit does not get exactly what it is expecting, it will 
ignore it. If the line has been typed correctly, the data will stop.

You may now poll the unit by typing A followed by “Enter”. This does an instantaneous poll of unit 2.	
A and returns the values once. You may type A “Enter” as many times as you like. Alternately you 
could resume streaming mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the 
unit from the streaming mode.

To assign the unit a new address, type *@=New Address, e.g. *@=B. Care should be taken not 3.	
to assign an address to a unit if more than one unit is on the RS-232 / RS-485 line as all of the 
addresses will be reassigned. Instead, each should be individually attached to the RS-232 / RS-485 
line, given an address, and taken off. After each unit has been given a unique address, they can all 
be put back on the same line and polled individually.

Tareing via RS-232 / RS-485 (L Series only): Tareing (or zeroing) the flow meter provides it 
with a reference point for zero flow. This is a very simple but important step in obtaining accurate 
measurements. It is good practice to “zero” the flow meter each time it is powered up. If the flow reading 
varies significantly from zero after an initial tare, give the unit a minute or so to warm up and re-zero it. 
If possible, it is helpful to zero the unit near the expected operating pressure by positively blocking the 
flow downstream of the flow meter prior to entering the Tare command. Zeroing the unit while there is 
any flow will directly affect the accuracy by providing a false zero point. If in doubt about whether the 
flow is positively blocked, remove it from the line and positively block both ports before entering the Tare 
command. If the unit reads a significant negative value when removed from the line and blocked, it is a 
good indication that it was given a false zero. It is better to zero the unit at atmospheric pressure and a 
confirmed no flow conditions than to give it a false zero under line pressure. To send a Tare command 
via RS-232 / RS-485, enter the following strings:

In Streaming Mode:		 $$V<Enter>
In Polling Mode:		  Address$$V<Enter>        (e.g. B$$V<Enter>)

Sending a Set-point via RS-232 / RS-485 (LC Series only): To send a set-point via RS-232 / RS‑485, 
“Serial” must be selected under the “Input” list in the control set up mode. To give controllers a set-
point, or change an existing point, simply type in a number between 0 and 65535 (2% over range), 
where 64000 denotes full-scale flow rate, and hit “Enter”. The set-point column and flow rates should 
change accordingly. If they do not, try hitting “Enter” a couple of times and repeating your command. 
The formula for performing a linear interpolation is as follows:

Value = (Desired Set-point X 64000) / Full Scale Flow Range

For example, if your device is a 500 CCM full-scale unit and you wish to apply a set-point of 125 CCM 
you would enter the following value:

 	 16000 = (125 CCM X 64000) / Full Scale Flow Range

If the controller is in polling mode as described in Changing from Streaming Mode to Polling Mode, the 
set-point must be preceded by the address of the controller. For example, if your controller has been 
given an address of D, the set-point above would be sent by typing:

 	 D16000 followed by “Enter”
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To adjust the Proportional and Differential (P&D) terms via RS-232 / RS-485 (LC Series only):

Type *@=A followed by “Enter” to stop the streaming mode of information.

To adjust the “P” or proportional term of the PID controller, type *R21   followed by “Enter”.

The computer will respond by reading the current value for register 21 between 0-65535. It is good 
practice to write this value down so you can return to the factory settings if necessary. Enter the value 
you wish to try by writing the new value to register 21. For example, if you wished to try a “P” term of 
220, you would type *W21=220 followed by “Enter” where the bold number denotes the new value.

The computer will respond to the new value by confirming that 21=220. To see the effect of the change 
you may now poll the unit by typing A followed by “Enter”. This does an instantaneous poll and returns 
the values once. You may type A “Enter” as many times as you like. Alternately, you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat step 3 to remove the unit from the 
streaming mode.

To adjust the “D” or proportional term of the PID controller, type *R22 followed by “Enter”.

The computer will respond by reading the current value for register 22 between 0-65535. It is good 
practice to write this value down so you can return to the factory settings if necessary. Enter the value 
you wish to try by writing the new value to register 22. For example, if you wished to try a “D” term of 
25, you would type *W22=25 followed by “Enter” where the bold number denotes the new value. 

The computer will respond to the new value by confirming that 22=25. To see the effect of the change 
you may now poll the unit by typing A followed by “Enter”. This does an instantaneous poll and returns 
the values once. You may type A “Enter” as many times as you like. Alternately you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat. 

You may test your settings for a step change by changing the set-point. To do this type A32000 (A is 
the default single unit address, if you have multiple addressed units on your RS-232 / RS-485 line the 
letter preceding the value would change accordingly.) followed by “Enter” to give the unit a ½ full scale 
set-point. Monitor the unit’s response to the step change to ensure it is satisfactory for your needs. 
Recall that the “P” term controls how quickly the unit goes from one set-point to the next, and the “D” 
term controls how quickly the signal begins to “decelerate” as it approaches the new set-point (controls 
the overshoot).
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Collecting Data:
The RS-232 / RS-485 output updates to the screen many times per second. Very short-term events 
can be captured simply by disconnecting (there are two telephone symbol icons at the top of the 
HyperTerminal® screen for disconnecting and connecting) immediately after the event in question. The 
scroll bar can be driven up to the event and all of the data associated with the event can be selected, 
copied, and pasted into Microsoft® Excel® or other spreadsheet program as described below.
For longer term data, it is useful to capture the data in a text file. With the desired data streaming to the 
screen, select “Capture Text” from the Transfer Menu. Type in the path and file name you wish to use. 
Push the start button. When the data collection period is complete, simply select “Capture Text” from 
the Transfer Menu and select “Stop” from the sub-menu that appears.
Data that is selected and copied, either directly from HyperTerminal® or from a text file can be pasted 
directly into Excel®. When the data is pasted it will all be in the selected column. Select “Text to 
Columns...” under the Data menu in Excel® and a Text to Columns Wizard (dialog box) will appear. 
Make sure that “Fixed Width” is selected under Original Data Type in the first dialog box and click “Next”. 
In the second dialog box, set the column widths as desired, but the default is usually acceptable. Click 
on “Next” again.  In the third dialog box, make sure the column data format is set to “General”, and click 
“Finish”. This separates the data into columns for manipulation and removes symbols such as the plus 
signs from the numbers. Once the data is in this format, it can be graphed or manipulated as desired. 
For extended term data capture see: “Sending a Simple Script to HyperTerminal®” on page 26.
Data Format:
The data stream on the screen represents the flow parameters of the main mode in the units shown on 
the display. For L Series Flow Meters, there are three columns of data. The first column is line pressure 
(normally in PSIG), the second column line temperature (normally in °C), and the third column is the 
volume flow rate in the units specified at time of order and shown on the display.

 +014.70 +025.00 +4.123
+014.70 +025.00 +4.123
+014.70 +025.00 +4.123
+014.70 +025.00 +4.123
+014.70 +025.00 +4.124
+014.70 +025.00 +4.125

L Series Water Flow Meter Data Format
For LC Series Flow Controllers, there are four columns of data representing pressure, temperature, 
volume flow and set-point. The first column is line pressure (normally in PSIG), the second column is 
temperature (normally in °C), the third column is volume flow rate (in the units specified at time of order 
and shown on the display), and the fourth column is the set-point (also in the units specified at time of 
order and shown on the display). For instance, if the meter was ordered in units of CCM, the display on 
the meter would read 2.004 CCM and the last two columns of the output below would represent volume 
flow and set-point in CCM respectively.

 +014.70 +025.00 +02.004 +02.004
+014.70 +025.00 +02.005 +02.004
+014.70 +025.00 +02.006 +02.004
+014.70 +025.00 +02.005 +02.004
+014.70 +025.00 +02.004 +02.004
+014.70 +025.00 +02.004 +02.004

LC Series Water Flow Controller Data Format
Note: On units with the totalizer function a fourth column (meters) or fifth column (controllers) will show 
the totalizer value
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Sending a Simple Script File to HyperTerminal®
It is sometimes desirable to capture data for an extended period of time. Standard streaming mode 
information is useful for short term events, however, when capturing data for an extended period of 
time, the amount of data and thus the file size can become too large very quickly. Without any special 
programming skills, the user can use HyperTerminal® and a text editing program such as Microsoft® 
Word® to capture text at user defined intervals.

1. Open your text editing program, MS Word for example.
2. Set the cap lock on so that you are typing in capital letters.
3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using MS Word, you can tell how 

many lines you have by the line count at the bottom of the screen. The number of lines will correspond 
to the total number of times the flow device will be polled, and thus the total number of lines of data it 
will produce.

For example:	A
	 A
	 A
	 A
	 A
	 A
will get a total of six lines of data from the flow meter, but you can enter as many as you like.

The time between each line will be set in HyperTerminal.

4. When you have as many lines as you wish, go to the File menu and select save. In the save dialog 
box, enter a path and file name as desired and in the “Save as Type” box, select the plain text (.txt) 
option. It is important that it be saved as a generic text file for HyperTerminal to work with it.

5. Click Save.
6. A file conversion box will appear. In the “End Lines With” drop down box, select CR Only. Everything 

else can be left as default.
7. Click O.K.
8. You have now created a “script” file to send to HyperTerminal. Close the file and exit the text editing 

program.
9. Open HyperTerminal and establish communication with your flow device as outlined in the manual.
10. Set the flow device to Polling Mode as described in the manual. Each time you type A<Enter>, the 

meter should return one line of data to the screen.
11. Go to the File menu in HyperTerminal and select “Properties”.
12. Select the “Settings” tab.
13. Click on the “ASCII Setup” button.
14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will tell the program how often 

to read a line from the script file you’ve created. 1000 milliseconds is one second, so if you want a line 
of data every 30 seconds, you would enter 30000 into the box. If you want a line every 5 minutes, you 
would enter 300000 into the box.

15. When you have entered the value you want, click on OK and OK in the Properties dialog box.
16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).
17. Browse and select the text “script” file you created.
18. Click Open.
19. The program will begin “executing” your script file, reading one line at a time with the line delay you 

specified and the flow device will respond by sending one line of data for each poll it receives, when it 
receives it.

You can also capture the data to another file as described in the manual under “Collecting Data”. You 
will be simultaneously sending it a script file and capturing the output to a separate file for analysis.
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TROUBLESHOOTING
Display does not come on or is weak.
Check power and ground connections and supply voltage.

Flow reading is approximately fixed either near zero or near full scale regardless of actual line 
flow.
Differential pressure sensor may be damaged. Avoid installations that can subject sensor to pressure 
drops in excess of 10 PSID. A common cause of this problem is instantaneous application of high 
pressure as from a snap acting solenoid valve upstream of the meter. Damage due to excessive 
pressure differential is not covered by warranty.

Displayed volumetric flow, pressure or temperature is flashing and message VOV, POV or TOV 
is displayed:
Our flow meters and controllers display an error message (VOV = volumetric overrange, POV = pressure 
overrange, TOV = temperature overrange) when a measured parameter exceeds the range of the 
sensors in the device. When any item flashes on the display, neither the flashing parameter nor the flow 
measurement is accurate. Reducing the value of the flashing parameter to within specified limits will 
return the unit to normal operation and accuracy.

Meter reads negative flow when there is a confirmed no flow condition.
This is an indication of an improper tare. If the meter is tared while there is flow, that flow is accepted as 
zero flow. When an actual zero flow condition exists, the meter will read a negative flow. Simply re-tare 
at the confirmed zero flow condition. Also note that while the meter is intended for positive flow, it will 
read negative flow with reasonable accuracy (it is not calibrated for bi-directional flow) and no damage 
will result.

My controller does not respond to the set-point.
Check the control set up screen to be sure the Input parameter selection matches the set-point you 
are trying to use. Also, be sure that the unit was ordered for the type of analog signal you are trying to 
use.

After installation, there is no flow.
Alicat Scientific LC Series controllers incorporate normally closed valves and require a set-point to 
operate. Check that your set-point signal is present and supplied to the correct pin and that the correct 
input is selected under the Input list in the control set up mode screen. Also check that the unit is 
properly grounded.

The flow lags below the set-point.
Be sure there is enough pressure available to make the desired flow rate. If either the set-point signal line 
and/or the output signal line is relatively long, it may be necessary to provide heavier wires (especially 
ground wiring) to negate voltage drops due to line wire length. An inappropriate PID tuning can also 
cause this symptom if the D term is too large relative to the P term. 

Meter does not appear to be accurate when compared against another valid measurement of the 
physical flow (such as weight over time).
Water flow meters can normally be compared against one another provided there are no leaks between 
the two meters. One common cause of inaccuracy, inconsistency, or unusual readings is air bubbles 
trapped in one or both of the legs of the differential pressure sensor. Bleed the ports as described in 
this manual to remove this possibility. Another possibility is that the water has some contaminant or 
additive, such as antifreeze, that affects the viscosity of the water. A third possibility is an improper tare 
error (see above).
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Controller is slow to react to a set-point change or imparts an oscillation to the flow.
An inappropriate PID tuning can cause these symptoms. Use at conditions considerably different than 
those at which the device was originally set up can necessitate a re-tuning of the PID loop.

Flow flutters or is jumpy.
The meters are very fast and will pick up any actual flow fluctuations such as from a diaphragm pump, 
etc. Also, inspect the inside of the upstream connection for debris such a Teflon tape shreds. Note: L & 
LC Series meters feature a programmable geometric running average (GRA) that can aid in allowing a 
rapidly fluctuating flow to be read. Please see “Pressure Averaging” and “Flow Averaging” on page 18.

The output signal is lower than the reading at the display.
This can occur if the output signal is measured some distance from the meter as voltage drops in the 
wires increase with distance. Using heavier gauge wires, especially in the ground wire, can reduce this 
effect.

My controller oscillates wildly and/or exhibits very different reactions to the set-point than I 
expect.
Conditions considerably different than those at which the device was originally set up can necessitate 
a re-tuning of the PID loop. Avoid long runs of small diameter tubing in the system, increase line size.

RS-232 / RS-485 Serial Communications is not responding.
Check that your meter is powered and connected properly. Be sure that the port on the computer to 
which the meter is connected is active. Confirm that the port settings are correct per the RS-232 / 
RS‑485 instructions in this manual (Check the RS-232 / RS-485 communications select screen for 
current meter readings). Close HyperTerminal® and reopen it. Reboot your PC.

Slower response than specified.
L Series Meters and LC Series Controllers feature a programmable Geometric Running Average (GRA). 
Depending on the full scale range of the meter, it may have the GRA set to enhance the stability/
readability of the display, which would result in slower perceived response time. Please see “Pressure 
Averaging” and “Flow Averaging” on page 18.

Jumps to zero at low flow.
L Series Meters and LC Series Controllers feature a programmable zero deadband. The factory setting is 
usually 0.5% of full scale. This can be adjusted between NONE and 3.2% of full scale. See page 18.
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Maintenance and Recalibration

General: L and LC Series Water Flow Meters and Controllers require minimal maintenance. The primary 
cause of damage and/or long-term inaccuracy in these devices is contamination and/or corrosion 
damage. Water should be filtered for particulates or biological materials that may grow in the device. 
When removing these units from the line for any extended period of time, make an effort to remove all 
of the water from the device, as deposits of calcium or other soluble minerals can affect the accuracy 
of the device.

Recalibration: The recommended period for recalibration is once every year. Providing that the CLEAN, 
DRY, and NON-CORROSIVE mantra is observed, this periodic recalibration is sufficient. A label located 
on the back of the meter lists the recalibration due date. The meter should be returned to the factory for 
recalibration near the listed due date. Before calling to schedule a recalibration, please note the serial 
number on the back of the meter. The Serial Number, Model Number, and Date of Manufacture are also 
available on the Manufacture Data 2 screen (page 17).

Cleaning: L and LC Series Flow Meters require no periodic cleaning. If necessary, the outside of the 
meter can be cleaned with a soft dry rag. Avoid excess moisture or solvents.

For repairs, recalibrations, or recycling of this product, contact:

Alicat Scientific, Inc.
7641 N Business Park Drive

Tucson, Arizona 85743
USA

Ph. 520-290-6060
Fax 520-290-0109

email: info@alicatscientific.com
Web site: www.alicatscientific.com

CCM CCH LPM LPH CFM CFH
CFH 0.0021 0.00003 2.1189 0.035 60.0 1.0
CFM 0.000035 0.0000005 0.035 0.00059 1.0 0.0166
LPH 0.06 0.001 60.0 1.0 1699.0 28.316
LPM 0.001 0.000017 1.0 0.0166 28.316 0.4719
CCH 60.0 1.0 60000.0 1000.0 1699011.0 28317.0
CCM 1.0 0.0167 1000.0 16.667 28317.0 471.947

Flow Conversion Table:
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Technical Data for Water Flow Meters & Water Flow Controllers
Specification L Series  LC Series LCR Series Description

Available Ranges 0.5CCM to 10LPM 5CCM to 500CCM 1LPM to 5LPM Full Scale
Accuracy ± 2 % Full Scale

Repeatability ± 2 % Full Scale
Operating Range 2% to 100% Full Scale Measure or Control

Typical Response Time 20 100 Milliseconds (Adjustable)
Operating Temperature +10 to + 50 ºCelsius

Zero Shift 0.02% Full Scale / ºCelsius / Atm
Span Shift 0.02% Full Scale / ºCelsius / Atm
Flow Rate 128% Measurable 102.4% Controllable Full Scale

Common Mode Pressure 100 PSIG
Supply Current 0.035 0.250 0.750 Amp
Supply Voltage 7—301 12—301 24-30 Vdc

Input /Output Signal Digital Pressure, Temperature and Flow RS-232 Serial or PROFIBUS1

Input /Output Signal Analog Volumetric Flow 0-5Vdc
Optional Input / Output 

Signal Secondary Analog Pressure, Temperature or Flow 0-5 Vdc; 0-10Vdc;4-20mA2

Electrical Connections 8 Pin Mini-DIN or DB-15

Mounting Attitude Sensitivity None Control response somewhat sensitive 
to inverted operation. Tare after installation 

Wetted Materials3 303 & 302 Stainless Steel, Viton®, Polyethermide, Silicon, Glass. LC and LCR Controllers 
Add: 400 Series Stainless Steel, Nickel. LC Controllers only also add Brass. 

1. If selecting PROFIBUS no analog signal is available.  PROFIBUS units do not have the display.  See PROFIBUS 
specifications for PROFIBUS supply voltages and currents.

2. 15 volts required for 4-20mA output.
3. If your application demands a different material, please contact Application Assistance for available options.

Mechanical Specifications

Full Scale Flow Mechanical
Dimensions

Process
Connections1 Pressure Drop2 (PSID)

L Series
0.5CCM to 1CCM 4.4”H x 2.4”W x 1.1”D M-5 (10-32) Female Thread* 2.0

2CCM to 500CCM
4.6”H x 2.4”W x 1.1”D 1/8” NPT Female 

2.0

1LPM 4.0

2LPM 

4.8”H x 2.7”W x 1.1”D 1/4” NPT Female 

4.0

5LPM 10.0

10LPM 20.0

LC Series
5CCM to 50CCM

4.6”H x 3.6”W x 1.1”D 1/8” NPT Female

5.0

100CCM 5.0

200CCM to 500CCM 7.5

LCR Series
1LPM 5.5”H x 7.9”W x 2.3”D 1/8” & 1/4”NPT Female 4.0

2LPM
5.7”H x 6.7”W x 2.3”D 1/4” NPT Female

4.0
5LPM 10.0

*Units ≤1CCM F.S. are shipped with M-5 (10-32) Male Buna-N O-ring face seal to 1/8” Female NPT fittings.
These adaptor fittings were selected for customer convenience in process connection. It should be noted that the 1/8” Female 
NPT introduces additional dead volume. To minimize dead volume, please see Accessories for the M-5 (10-32) Male to 1/8”OD 
compression fitting.

1. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings.
2. Lower Pressure Drops Available, Please contact the manufacturer.
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Rev. No. Description Date

L Series:
0 - 0.5CCM
0 - 1CCM

L Series:
0 - 2CCM
0 - 5CCM
0 - 10CCM
0 - 20CCM
0 - 50CCM
0 - 100CCM
0 - 200CCM
0 - 500CCM

0 - 1LPM



32






  





















       

 
























Alicat Scientific, Inc.












 







2045 N. Forbes Blvd. Suite 103  Tucson, AZ 85745
520-290-6060 Ph.  520-290-0109 Fax

















L Series:
0 - 2LPM
0 - 5LPM
0 -10LPM





















       

 









 












 






520-290-6060 Ph.  520-290-0109 Fax


2045 N. Forbes Blvd. Suite 103  Tucson, AZ 85745








Alicat Scientific, Inc.


 













 








 







Rev. No. Description Date

LC Series:
0 - 5CCM
0 - 10CCM
0 - 20CCM
0 - 50CCM
0 - 100CCM
0 - 200CCM
0 - 500CCM
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























       

 

























 520-290-6060 Ph.  520-290-0109 Fax
2045 N. Forbes Blvd. Suite 103  Tucson, AZ 85745










Alicat Scientific, Inc.



















 








 















Rev. No. Description Date

LCR Series:
0 - 1LPM



























       

 

























 520-290-6060 Ph.  520-290-0109 Fax
2045 N. Forbes Blvd. Suite 103  Tucson, AZ 85745










Alicat Scientific, Inc.



















 










 














Rev. No. Description Date

LCR Series:
0 - 2LPM
0 - 5LPM
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Technical Data for PROFIBUS Water Flow Meters and Controllers

1. NC
2. OPT GND
3. DP
4. RTS
5. DGD
6. VP
7. OPT 7 to 30VDC
8. DN
9. NC

5 1
9 6

TOP

1. NC
2. RS232TX
3. RS232RX
4. NC
5. GND
6. NC
7. 7 to 30VDC
8. GND
9. NC

1
6

5
9

SIDE

NOTICE: The following specifications are applicable to Alicat PROFIBUS enabled mass 
meters and mass controllers only. 
All standard device features and functions are available and operate in accordance with the 
standard Alicat Scientific device operating manual provided with the device.

Power and Signal Connections:
Connect to the device using two DB9 connectors.
The female top connection is PROFIBUS. 
The male connection on the side is power and RS-232.
Pin out diagrams for all PROFIBUS enabled Alicat devices 
are shown:

Specification L Series  LC Series LCR Series Description

Available Ranges 0.5CCM to 10LPM 5CCM to 500CCM 1LPM to 5LPM Full Scale
Accuracy ± 2 % Full Scale

Repeatability ± 2 % Full Scale
Operating Range 2% to 100% Full Scale Measure or Control

Typical Response Time 20 100 Milliseconds (Adjustable)
Operating Temperature +10 to + 50 ºCelsius

Zero Shift 0.02% Full Scale / ºCelsius / Atm
Span Shift 0.02% Full Scale / ºCelsius / Atm
Flow Rate 128% Measurable 102.4% Controllable Full Scale

Common Mode Pressure 100 PSIG
Supply Voltage: Amp

Meters 7 to 30 Vdc Vdc
Small Valve Controllers 12 to 30 Vdc RS-232 Serial 
Large Valve Controllers 24 to 30 Vdc 0-5Vdc

Supply Current 80mA @ 12Vdc
65mA @ 24Vdc

295mA @ 12Vdc
280mA @ 24Vdc 0-5 Vdc; 0-10Vdc;4-20mA1

Mounting Attitude 
Sensitivity None Mini-DIN

Mounting Attitude Sensitivity None Control response somewhat sensitive 
to inverted operation. Tare after installation 

Wetted Materials2 303 & 302 Stainless Steel, Viton®, Polyethermide, Silicon, Glass. LC and LCR Controllers 
Add: 400 Series Stainless Steel, Nickel. LC Controllers only also add Brass. 

1. 15 volts required for 4-20mA output.
2. If your application demands a different material, please contact Application Assistance for available options.
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Flow body dimensions will vary with range. Please see Alicat’s device specifications for flow body dimensions.

MC-1SLPM-DS-PROFIBUS

1/8 NPT
Both Sides

1.05

.525

.35

.925

.125
.150

3.76
3.59

.525

.35

4.264.05

2.225
2 x 8-32 UNC ┬v  .350

MC-1SLPM-PROFIBUS

2 x 8-32 UNC ┬v  .350

.525

.35

4.264.08

3.76

3.59

1/8 NPT
Both Sides

1.05

.525

.35

2.225
.150 .125

.925

M-1SLPM-PROFIBUS

2 x 8-32 UNC ┬v  .350
2.225

.150
.125

.925

4.26 4.08

1/8 NPT
Both Sides

1.05

.525

.35

.525

.35

2.542

2.375

Example Dimensions for PROFIBUS enabled devices.



36

Option: Totalizing Mode
L and LC Series Flow Meters and Controllers can be purchased with the Totalizing Mode option. This 
option adds an additional mode screen that displays the total flow (normally in the units of the main flow 
screen) that has passed through the meter or controller since the last time the totalizer was cleared. 
The Totalizing Mode screen shown below is accessed by pushing the “MODE” button until the label 
over it reads “Total”. If your meter is ordered with Totalizing Mode option, pushing the “Mode” button 
once will bring up the “Totalizing Mode” display.  Pushing “Mode” a second time will bring up the “Select 
Menu” display. Pushing it a third time will return you to the Main Mode Screen.

 Hours    Volume  Clear
    0.3     0.00

		           
		           CC
		           Water

   
+0.0 SCCM

	    Total

Counter – The counter can have as many as six digits. At the time of order, the customer must specify 
the resolution of the count. This directly affects the maximum count. For instance, if a resolution of 
1/100ths of a liter is specified on a meter which is totalizing in liters, the maximum count would be 
9999.99 liters. If the same unit were specified with a 1 liter resolution, the maximum count would be 
999999 liters.

Rollover – The customer can also specify at the time of order what the totalizer is to do when the 
maximum count is reached. The following options may be specified:

No Rollover – When the counter reaches the maximum count it stops counting until the counter is 
cleared.
Rollover – When the counter reaches the maximum count it automatically rolls over to zero and continues 
counting until the counter is cleared.
Rollover with Notification – When the counter reaches the maximum count it automatically rolls over to 
zero, displays an overflow error, and continues counting until the counter is cleared.

Hours.–.The display will show elapsed time since the last reset in 0.1 hour increments. The maximum 
measurable elapsed time is 6553.5 hours (about nine months). The hours count resets when the “clear” 
button is pushed, an RS-232 or RS-485 clear is executed or on loss of power

Clear – The counter can be reset to zero at any time by pushing the dynamically labeled “Clear” button 
located above the upper right side of the display. To clear the counter via RS-232 / RS-485, establish 
serial communication with the meter or controller as described in the RS-232 / RS-485 section of the 
manual.  To reset the counter, enter the following commands:

	 In Streaming Mode:  $$T <Enter>		 (Note: RS-485 units do not have a streaming mode.)

	 In Polling (addressable) Mode:  Address$$T <Enter>      (e.g. B$$T <Enter>)
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Alicat Portable Meters and Gauges

Alicat Portable Flow Meters and Gauges use a common 9 Volt battery located in the top section of your 
meter. 
Output signals from the flow meter are passed through the female connector on top of the flow meter. 
Turn the switch on top of the flow meter “off” when the meter is not in use.
Normal (9V alkaline) battery life is approximately 8 hours (30-40 hours with a 9V-lithium battery), 
however many factors can affect this. 
Replace the battery as often as required. A yellow LED indicates low voltage and that the battery should 
be replaced. 
A false signal can result when the voltage drops below its normally regulated level. 
Alicat Portable Flow Meters and Gauges can also be powered by an optional AC/DC plug-in wall adaptor. 
With the adaptor plugged into the flow meter, the battery is bypassed and the meter will operate solely 
off the adaptor power supply.

Replacing the Battery:  
Remove the four Phillips head screws from the front cover and gently remove it as shown below.1.	
Remove the 9V battery, pulling the top of the battery out first.2.	
Disconnect the old battery from the harness and replace it with a new battery.3.	
Install the new battery bottom end first and replace the back cover so that the cushioning pad 4.	
presses directly down on the battery.
Replace the four Phillips head screws.5.	

Battery cover removal
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Option: Remote Electronics for High Line or Gas Temperatures
Some applications involve operating temperatures outside the standard Alicat device specifications. A 
solution using remote electronics is available. (This option is not applicable to liquid devices.)
The flow body’s components are minimized to only the required sensors. The flow data is sent to 
the microprocessor electronics up to 6 feet away from the sensor package. Relocating the sensitive 
electronics, including the LCD, allows for installation of the flow body in ambient temperatures as high 
as 85° Celsius with gas temperatures under 100°Celsius. 

In these applications we recommend our custom gauge calibration at a gas temperature of up to 
70°Celsius. This will reduce zero shift errors that occur when actual gas flow temperatures deviate 
substantially from the gas calibration temperature. This configuration is also used in integrations that 
require a compact flow package at the installation point.

Maximum distance 
between electronics 
and sensor package is 
6 feet.

Accessory: BB-9 Multi-Drop Box
The BB-9 Multi-Drop Box makes it convenient to wire multiple flow and/or pressure 
devices to a single RS‑232 port. (Note: BB-9 is not compatible with RS-485.)
The Multi-Drop Box has nine 8 pin mini-DIN ports available. The ports are to be used 
with a standard double ended 8 pin mini-DIN (DC-62) style cable going from the box 
to each flow or pressure device. A single DB9 D-SUB type connector (COM PORT) 
connects, using the included cable, to the serial connector on a PC or laptop. 
All of the flow and/or pressure devices are powered via a terminal block on the front 
of the box. 

If more than nine devices will be required, additional Multi-Drop Boxes can be daisy chained together 
with a double ended 8 pin mini-DIN cable plugged into any receptacle on both boxes.
BB-9 Power Supply for Large Valve Controllers: The PS24VHC (Power Supply 24Vdc High Current) 
is a 6.5Amp 24Vdc power supply designed for running multiple large controllers on a BB-9. 
The 6.5Amp power supply can run as many as 8 large valve controllers, which makes it ideal for the 
BB9 and multiple large valve (or small valve / large valve combination) controllers on a BB-9.
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Accessory: Flow Vision™ SC Software
Flow Vision™ SC is an intuitive software interface to help 
your test cycles run smoother and shorten your engineering 
time! 

Flow Vision™ SC lets you connect to and communicate 
with multiple Alicat units simultaneously. Now you can view 
virtual displays, control tabs, charts and data lines from every 
connected Alicat device on the same screen.

Flow Vision™ SC supports all RS-232 and RS-485 Serial 
communication functions, including: gas selection, tareing, 
set‑point control, valve tuning and flow averaging.

Session Saving: Save and reload your configuration data with confidence. 

Script Building: Create scripts to adjust a controller’s set-point value at variable specified time intervals.

Charting: Chart as many parameters as you want off as many devices as you want, with color coding, 
zooming, and printing functionality.

Alarms: Create software alarms that will notify you of given parameter conditions.

Data Capture & Logging: Capture and log data to either a .csv file or a .txt file. Improved Data Logging 
and Data Log File Splitting for easy to manage data.

Flow Vision™ SC supports multiple devices connected to 
the same RS-232 or RS-485 port.
Simply connect each device to a BB-9 Multi‑Drop Box, 
then using device addressability, assign an identifier to each 
instrument. (Note: BB-9 is not compatible with RS-485.)
Now you can easily monitor and control multiple Alicat 
instruments from your computer. 

Devices

Scripts

Data Logs

Charts

Terminals
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Accessories
Part Number Description

FLOWVISIONSC Flow Vision™ SC software for interface with all Alicat instruments
BB-9 Multi-Drop Box
PS24VHC High current power supply for BB-9 use with Large Valve Controllers
PCASE Industrial carry and storage case for portable meters/gauges
DC-61 8 Pin Male Mini-DIN connector cable, single ended, 6 foot length
DC-251 8 Pin Male Mini-DIN connector cable, single ended, 25 foot length
DC-301 8 Pin Male Mini-DIN connector cable, single ended, 30 foot length
DC-501 8 Pin Male Mini-DIN connector cable, single ended, 50 foot length
DC-751 8 Pin Male Mini-DIN connector cable, single ended, 70 foot length
DC-6RT 8 Pin Male Right Angle Mini-Din Cable, single ended, 6 foot length
DC-62 8 Pin Male Mini-DIN connector cable, double ended, 6 foot length
DC-252 8 Pin Male Mini-DIN connector cable, double ended, 25 foot length
DC-502 8 Pin Male Mini-DIN connector cable, double ended, 50 foot length
DC-602 8 Pin Male Mini-DIN connector cable, double ended, 60 foot length
MD8DB9 8 Pin Male Mini-DIN to DB9 Female Adapter, 6 foot length
IC10 Industrial cable, 6 Pin, single ended, 10 foot length
IC10-18G 18 gauge industrial cable, 6 Pin, single ended, 10 foot length
IC20 Industrial cable, 6 Pin, single ended, 20 foot length
IC24-18G 18 gauge industrial cable, 6 Pin, single ended, 24 foot length
IC50 Industrial cable, 6 Pin, single ended, 50 foot length
PVPS24U Universal 100-240 VAC to 24 Volt DC Power Supply Adapter
USB-RS232 RS-232 to USB Converter
REMOTE Remote electronics with display
RD Remote Panel Mount Display

MNPT to Compression Fittings
10-32 - 1/8” SS-200-1-0157
10-32 - 1/4” SS-400-1-0256
1/8” - 1/8” SS-200-1-2
1/8” - 1/4” SS-400-1-2
1/8” - 3/8” SS-600-1-2
1/8” - 1/2” SS-810-1-2
1/8” - 3mm SS-3M0-1-2
1/8” - 4mm SS-4M0-1-2
1/8” - 6mm SS-6M0-1-2
1/8” - 8mm SS-8M0-1-2
1/8” - 12mm SS-12M0-1-2
1/4” - 1/8” SS-200-1-4
1/4” - 1/4” SS-400-1-4
1/4” - 3/8” SS-600-1-4
1/4” - 1/2” SS-810-1-4
1/4” - 3mm SS-3M0-1-4
1/4” - 4mm SS-4M0-1-4
1/4” - 6mm SS-6M0-1-4
1/4” - 8mm SS-8M0-1-4
1/4” - 12mm SS-12M0-1-4

Filters & Elements FNPT-MNPT
10-32 5μ 510053
10-32 20μ 510054
1/8” 20μ ILF-1/8-20
1/4” 40μ ILF-1/4-40
1/2” 40μ ILF-1/2-40*
3/4” 40μ ILF-3/4-40*

20μ element ILFE20
40μ element ILFE40
40μ element ILFE40L*

Filters & Elements FNPT-FNPT*
10-32 5μ CF-303-20-316

*requires MNPT to MNPT coupler 
to interface with Alicat flow bodies

10-32 Male UNF to 1/8 FNPT Adapter
410133

Male M5 (10-32) Buna-N O-ring face seal to 1/8”Female NPT

MNPT to Compression Fittings
1/2” - 1/8” SS-200-1-8
1/2” - 1/4” SS-400-1-8
1/2” - 3/8” SS-600-1-8
1/2” - 1/2” SS-810-1-8
1/2” - 3/4” SS-1210-1-8
1/2” - 6mm SS-6M0-1-8
1/2” - 8mm SS-8M0-1-8
1/2” - 12mm SS-12M0-1-8
1/2” - 16mm SS-16M0-1-8
3/4” - 1/4” SS-400-1-12
3/4” - 1/2” SS-810-1-12
3/4” - 3/4” SS-1210-1-12

3/4” - 12mm SS-12M0-1-12
3/4” - 16mm SS-16M0-1-12
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Mini-DIN to DB-9 Connection for RS-232 Signals
RS-232 Digital Output Signal
If you will be using the RS-232 output signal, it is necessary to connect the RS-232 Output Signal 
(Pin 5), the RS-232 Input Signal (Pin 3), and Ground (Pin 8) to your computer serial port as shown in 
above. Adapter cables are available from the manufacturer or they can be constructed in the field with 
parts from an electronics supply house. 
Note that the diagrams represent the “port” side of the connections, i.e. the connector on top of the 
meter and the physical DB-9 serial port on the back of the computer. The cable ends will be mirror 
images of the diagram. 

Eight Pin Mini-DIN Connector Pin-Outs
If your Alicat Instrument was ordered with the standard Eight Pin Mini-DIN 

connection, please be sure to reference the following pin-out diagram.

7

4

6

21

DB-9 Serial Port

5

5----------Ground--------------------------------------Ground----------8
3----------Transmit------------------------------------Receive---------3
2----------Receive-------------------------------------Transmit--------5

8 Pin Mini-DIN Port

8

1 2 3 4 5

6 7 8 9
3

 

4 5

6 7 8

2

3

1

5----------Ground--------------------------------------Ground----------8
3----------Transmit-------------------------------------Receive---------3
2----------Receive--------------------------------------Transmit--------5

A locking industrial connector is standard on all CSA/ATEX approved devices. It is also available as an 
option on all other Alicat instruments.

1
6

5

4
3

2

Pin Function Cable Color
1 Power In  ( + ) Red
2 RS-232TX / RS-485 + Blue
3 RS-232RX / RS-485 - White
4 Remote Tare (Ground to Tare) Green
5 Ground (common for power,

                     communications and signals)
Black

6 Signal Out (Voltage or Current as ordered) Brown

Six-pin Industrial Connector
Note: The above pin-out is applicable to all the flow meters and controllers ordered with the industrial 
connector. The availability of different output signals depends on the flow meter options ordered.

Locking Industrial Connector Pin-Outs
If your Alicat Instrument was ordered with a Six Pin Locking Industrial 
connection, please be sure to reference the following pin-out diagram.
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PROFIBUS Pin-Outs
If your Alicat Instrument was ordered with a PROFIBUS connection, 

please be sure to reference the following pin-out diagram.

1. NC
2. OPT GND
3. DP
4. RTS
5. DGD
6. VP
7. OPT 7 to 30VDC
8. DN
9. NC

5 1
9 6

TOP

1. NC
2. RS232TX
3. RS232RX
4. NC
5. GND
6. NC
7. 7 to 30VDC
8. GND
9. NC

1
6

5
9

SIDE

Power and Signal Connections:
Connect to the device using two DB9 connectors.
The female top connection is PROFIBUS. 
The male connection on the side is power and RS-232 or RS-485.
Pin out diagrams for all PROFIBUS enabled Alicat devices are shown below.
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DB15 Pin-Out

Note: The above pin-out is correct for units with a DB15 pin‑out. If your unit is 
marked DB15H or DB15K, you must use the correct pin-out (as shown on the 
following page).

Pin Number Function
2 Signal Out
5 Supply
8 Tare (meters)

Set-Point (controllers)
9 Ground
11 Secondary Out
13 RS-232 RX

RS-485 –
15 RS-232 TX

RS-485 +

8

1513119

2 5

DB15 Pin-Outs
If your Alicat Instrument was ordered with 

a DB15 connection, please be sure to 
reference the appropriate pin-out diagram.
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DB15H Pin-Out
Pin Number Function

6 Signal Out
7 Ground
11 Supply
14 Tare (meters)

Set-Point (controllers)
10 Secondary Out
2 RS-232 RX

RS-485 –
15 RS-232 TX

RS-485 +

7

11 14
1510

2 6

DB15K Pin-Out
Pin Number Function

2 Signal Out
5 Ground
7 Supply
8 Tare (meters)

Set-Point (controllers)
9 Secondary Out
13 RS-232 RX

RS-485 –
14 RS-232 TX

RS-485 +

7 8

14139

2 5

DB15 Pin-Outs
If your Alicat Instrument was ordered with 

a DB15 connection, please be sure to 
reference the appropriate pin-out diagram.

Note: The above pin-outs are correct for units with a DB15H or DB15K pin‑out. 
If your unit is marked DB15, you must use the correct pin-out (see the previous 
page).
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